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INTRODUCTION

Address Book for Windows is an application that you can use to create and maintain a database of names,
addresses, and phone numbers.  While the Cardfile included with Windows 3.0 has this capability, Address
Book  is  a  more  specialized  program,  providing  you  with  several  more  options  to  make  phone  list
management more efficient.  Address Book for Windows also includes several easy to use accessories
including a temporary notepad, a memo writer, and a search option to create custom phone lists from a
master file.  You have several print options to give you more flexibility in choosing the type of phone listing
you desire.

Address Book for Windows was written in Visual Basic.  Since this environment requires Standard or 386
Enhanced mode, you must ensure you are in either of those operating modes before attempting to run the
program.  Additionally, this program was designed to be used on SVGA displays (800x600 resolution or
higher).  Using this program on a standard 640x480 VGA screen will have unpredictable results and should
not be attempted.  If you desire a copy of this program that is VGA compatable, please contact us at once
and we will produce one for you in short order.

With such restrictive limitations, you may ask "Why use Visual Basic at all?"  For starters, the limitations
are by our own design.  We wish to expend our time in a productive manner and will attempt to do so by
targeting certain user types with specific programs.  If there is feedback indicating preferences for other
design options such as the previously mentioned graphics capability,  we can easily accomodate these
requests.  Another reason to develope and exploit  Visual Basic is for economy reasons.  Due to the low
cost and high support of Visual Basic, we can provide quality applications for an extremely reasonable cost.
This fact coupled with the modular nature of Visual Basic will allow us to provide custom versions of our
products to any user who requests it.  We can provide these modified versions in a minimum amount of
time to help get you going again.
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Getting Started

INSTALLING THE ADDRESS BOOK

There are no special requirements or utilities required to install the program.  Installation involves the
same simple process required to install any program in your Windows environment.  You should insure that
the  file  VBRUN100.DLL  is  included  in  the  same  directory  as  your  program  or  located  within  the
specifications of your Path statement.   Let's get started now.

1. Select the Program Group where you wish to place the Address Book in.

2. Select NEW from the File Menu in the Program Manager.

3. Select Program Item from the dialog box that appears and click OK.

4. Enter a description (ex Address Book) in the top text box.

5. In the next box, enter the pathname for the file and press the OK button.

The program's icon should now appear in the Program Group that you had selected.  You also have the
option  of  using  the  Windows  Setup  utility  to  install  the  program,  however  using  this  method  takes
considerably longer to complete the installation process.  Once this process is complete, the Address Book
will be ready to run.  As a side note, there is only one icon included with this file.  If you decide to change
it, you must follow the directions in the Windows manual for using icon libraries.

BEGINNING TO USE THE ADDRESS BOOK

Starting the Address Book is  a relatively simple matter.   The program does not accept command line
parameters at this time and is not associated with any specific data file extension.  To get started;

1. Double-Click on the Address Book icon while in the program manager

2. You may also select RUN from the File menu and enter the filename and/or pathname

Once you have done this the file will load and in a few seconds you will  see the main display screen.
During the loading process, Address Book creates several temporary files for it's  own use.  While the
program is running, either as the active Window or in the background, you should NEVER delete any of
these temporary files.  You can recognize them by the ~TMP or ~PST prefix.  Should you encounter a UAE
or any other type of fatal error that causes the program to terminate, you may then go and delete these
files prior to running the Address Book for a second time.  Under normal circumstances, Address Book
deletes these files when they are no longer needed.  If you are running the program for the first time, there
may not be a file called sercomm.cfg in your set.  The Address Book will automatically create this file for
you and advise you that the modem configuration needs to be redone.

At this point you should have the Address Book displayed and ready to begin working with telephone lists.
The next section will cover some of the basic commands necessary to become proficient with it.  Included
is a sample file that will be refered to several times to highlight specific functions and options you have
available.
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Using Address Book Files

OPENING A DATA FILE

Included with this package is a sample data file called  sample.abk and we will be using this file as an
example.  You may load up this file while going through this section and experiment with the commands
we will be covering.  The steps to load a data file are similar to all other Windows applications and you are
probably already familliar with them.  We will cover the steps anyways for those who aren't.

1. Select  OPEN from the File menu along the top of the Address Book.  A standard Open File
dialog box will     appear.  Note the wildcard pattern in the filename box.

2. In the file list box, you should see the sample.abk file, click on this file and press  OK.  The
selected data file     should now begin loading.

3. Once the sample data file is loaded, you will see entries in the directory index list box on the
lower portion of     the screen.  This is the index into the data file and provides overall control for
the file system.

CREATING A NEW DATA FILE

The  Address  Book initially  works  with  temporary  files  and  renames  them upon  saving  or  exiting  the
program.  From a programming point of view, this allows for easier maintenance of the individual records.
Whenever Address Book is started, it automatically creates a temporary file and sets it's internal pointers
to the first record.  This is the same procedure that occurs whenever you select to create a new file.  You
should observe our previous warning concerning the deletion of these temporary files while the program is
running.  Doing so will corrupt any data you have stored.  The steps to create a new file are quite simple.

1. Select NEW from the File menu on the top of the screen.  You should now be ready to begin 
entering the     data for your new file.

During this process, you may be prompted to store a record or save a file if that has not been 
accomplished prior to selecting the New option.  These actions will not interfere with starting a new file.

SAVING A DATA FILE

You are presented with two options to save your files, the Save and the Save As commands.  The difference
between the two is mainly the Save As option allows you to rename the file your are currently working
with.   During the course of  file activity,  records are duplicated,  deleted,  and overwritten many times.
Program control is maintained through a system of pointers and indexes.  What you can and will end up
with is a data file size much larger than the program pointers indicate.  The Address Book has built in
maintenance routines which eliminate at the duplicated records tacked on to the end of a data file.  These
routines are utilized throughout the session but also are called by selecting the Save option.  This updates
your current data file with no other intervention required.  However, if you have created a new file and
have not saved it yet using the Save As option, selecting Save will  also prompt your for a permanent
filename to use through a standard Windows Save File dialog box.  This dialog box defaults to the current
filename if  working with  a permanent data file.   There may be instances where the full  pathname is
specified as a save filename, this is normal and will be truncated down to the filename portion by pressing
the OK button.

1. Select SAVE or SAVE AS from the File menu.

2. When the dialog box appears, enter the desired filename into the text area.

3. Click OK when ready to proceed with the save.
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To protect the database integrity from destruction due to inadvertant use of illegal filenames, a default
extension of ABK is used on all filenames.  Even if you specify a different extension when activating the
save command, that extension will be removed and the proper one put in it's place.    This will help ensure
continuity with the search and print functions amd prevent any loss of data during these operations.  

PRINTING A DATA FILE

The Address Book's print options allow you some flexibility on how you want your output to appear.  While
the layout of the page is pretty much rigid, you do have the option on which fields to print, include the
record index, add a blank page at the end, and to print an index listing which is  referenced by page
number to all the indexes in the file.  Also, you may select Last Search file print, single data file print, and
multiple data file printing.  You can include a header and footer block, each 30 characters in length.  To get
started, we'll cover each of the file print options and  the steps necessary to accomplish them.

Last Search File Print

1. To print the Last Search file, first select PRINT from the file menu.  Choose LAST SEARCH from
the Select                           File  option frame.  There are no other options you can select for this item so
click PRINT and the file      should  begin  printing  or  should  be  sent  to  the  Print  Manager
depending on your driver is configured

Single Data File Print

With this option you can select a data file from any location to print.  You will notice the print window has
file controls that are almost identical to that of the open file selection box.  This is to allow you to choose
from a variety of sources.  You should be aware of the fact that if you select files from a floppy drive, even
after you add the name to the queue the disk must remain in the drive.  During the printing process, the
data file is read and you will generate a potentially fatal error if you have removed the disk.  To begin,
follow the steps below.

1. Select the directory list box to your desired directory.  Any Address Book files in the directory
will show up in     the file list box.

2. To select a file for printing, click on the filename to highlight it.  Then click the ADD FILENAME
TO QUEUE      button to place the file in the file queue.  You can also double-click on the
filename to add it to the queue.

3. Select SINGLE DATA FILE from the Select File Option frame.  If you have more than one file in
the file     queue,  you  can  highlight  the  filename  in  the  queue  to  specify  that  singe  file.
Otherwise the first name in the     list will be the file that's printed.

4. Select the desired fields that you wish to print from the Select Fields frame.  If you plan on
creating an index     table, you must include the index in your selection from the frame.

5. Click the ADD BLANK PAGE checkbox if you want a blank page added at the end.  These are
useful for     annotating changes before you have a chance to update your database.

6. Click INCLUDE INDEX TABLE if you want one printed at the end.  For this option to work, you
must have     the Index field selected to print.  If not you will get a message box advising
you of this.  When you exit the     message box, the Index field will automatically be selected
for you.

7. You can enter a header string in the header block.  You are limited to 30 characters for the
header string.

8. You can also enter a footer string using the same 30 character limit as the header.

Multiple Data File Print

With this option, you can place up to 10 data files in the file queue and have them printed out in the order
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that they were added.  The file queue may be changed prior to begining the printing by selecting a file and
clicking the REMOVE FILE FROM QUEUE button.  With this option, you will not be prompted for a title to
place on the title page.  Instead there will be a generic "Address Book" title.  The procedure for selecting
options is identical to the steps for printing a single data file and should be followed once the queue is set.
Again remember that if a file is selected from a floppy disk, that disk must remain in the drive for it to be
read and the program to function properly.
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Using Address Book Records

ADDING A NEW RECORD TO THE FILE

Adding a record to the database is a fairly simple procedure.  To begin, you should have the address book
loaded and ready to go.  The procedure on adding a record to a new file or to a previously opened one is
the same.  Simply click on the ADD NAME button.  An input box will appear asking you to type in an index
for the record.  This index is very important to the operation of the file.  The index determines where in the
file the record will be stored at.  Also, all other functions affecting the file and any records use this index for
access.   You should give some thought on what you want your index to be for various records.  For
individual names, the most common would be the last name of the individual.  For business names and
numbers, you may want to use an index by a category determined for example by the type of service the
business performs.  What ever you decide to enter, this index will be stored alphabetically in the index list
directory towards the bottom of the screen.  From there you can tab through to the individual text boxes
and enter the necessary information.  You should note that the text boxes will not accept any input until
you have completed the index entry step.  Let's review the steps now in entering a new record.

1. Click the ADD NAME button

2. Enter your desired index into the input box that appears.

3. You should see the index appear in the directory index and index search boxes.

4. You can now enter a name in the NAME text box.  Use the mouse or tab button to advance to
the address     box

5. Enter the address in the ADDRESS text box.  When done, advance to the City/State box.

6. Enter the city and state in the CITY/STATE text box.  Again advance to the next box.

7. Enter a phone number in the TELEPHONE text box.  If you plan on using a modem to autodial
a selected     phone number, there is a format you should follow.  For local area phone
numbers, you can enter the number     as a 7 digit number, ex. 734-4288.  If the number is a long
distance number, you should use the following     format,  1  -  ###  -  ####  or  as  an
example, 1-402-734-4288.  If you do not plan on using a modem, you can     enter  the
number in any style you desire.

8. When you have finished entering all  the data, click the  STORE NAME button to place the
record into the file.

The Address Book checks each record to see that it was stored before moving to a different function.  It
advises you if the record was not stored and gives you the option of storing it before moving on.  For
example, if you are entering several numbers, you can click Add Name instead of Store Name.  You will be
prompted to store or cancel the record.  Click on your desired response and the index input box will then
appear as you start the entry process over again.

DELETING A RECORD FROM THE FILE

To delete a record from the file, you should have the targeted record displayed and it's index highlighted.
These two items must match or the deletion will not take place.  You will be advised of the discrepancy and
the Address Book will reset the display to the highlighted index on the assumption that the record you wish
to remove is the highlighted index.  The steps are as follows.

1. Select and display the record you wish to delete.

2. Click on the DELETE NAME button.

3. The text boxes will clear and the index will be removed from the file.

Use caution during this step.  There are no confirmation warnings that a record is about to be deleted.
Because it is a two step process to delete a file, inadvertant deletes should not be a problem.  There is
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however no way to recover a record once it's gone so do be careful.
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VIEWING A RECORD

The process of viewing a record accomplishes several things.  First of course the actual record is displayed.
Secondly  the  program sets  internal  pointers  to  indicate  which  index  is  selected  and  which  record  is
displayed.  This keeps the file system in synch with user commands.  The process of viewing a record is
then the first step in several other command procedures such as deleting a name and storing a name after
an edit operation.  Also you must complete the steps to view a record to use the autodial function.  Viewing
a record is quite simple as the steps below will indicate.

1. With a data file loaded into the index directory, click on the index  you wish to view.  This
should highlight it.

2. Next click on the VIEW NAME button.

3. The selected record should now be displayed.

4. As an alternate method, you can double-click on an index in the index directory and it will be
displayed.

5. Finally, if you have a record already in view, you can click on the index entry to highlight it,
then by clicking in     any of the text boxes above will  cause the selected index to be
displayed.  The purpose of this function is to     prevent an index being referenced for one
record while another record is edited.  

EDITING A RECORD

Editing a record is a simple process that involves the steps necessary to view a record, make the desired
change, then storing the record.  To make a change to a record,  follow these steps.

1. Select an index and display the record using the previously mentioned methods.

2. With the mouse or tab control, move to the text box that you wish to change.  When using a
mouse you can     click at the location of the desired change.  When using a keyboard, use the
tab and cursor keys to move the     cursor to the location where you wish to make the change.

3. Make your desired change to the displayed data.

4. When complete with the change, click the STORE NAME button to save your change.

You will see as the record is stored that all the fields are cleared in the process.  This is an indicator that
the change has successfully taken place.  To make more changes, follow the steps again.

SAVING VERSUS STORING

When you work the an Address Book data file, the process of adding, deleting, and storing records creates
duplicate records that are tacked on to the end of the data file.  You will never have access to these files
since internal program pointers reflect the current upper limit of valid data records and do not show these
duplicated records.  When you select a new file to open or exit the program, these duplicated records are
deleted and the file is cleaned up and saved.  As a general housekeeping measure though, selecting the
SAVE option from the File menu will perform this function and still remain in the active data file.  This is a
wise move if you are doing extensive maintenance on a data file.  

DIRECTORY INDEX SEARCHING

You will notice the Address Book does not have an elaborate search system for the directory index.  Up till
now we have had to use the scroll bars to scan through our index list to find a record we want.  This could
become very cumbersome and slow when working with a large file.  The feature here to quickly search or
scan through our index listing is very similar to the Windows Help System Topic Search function.  You will
see a text box immediately above the directory index list box.  From this box we can enter search strings
and the directory index will display the first match it finds.  With every letter that's entered into this box,
the search becomes more accurate and closer to our desired string.  To illustrate this procedure, open the
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sample.abk file form the address book.  You will see that we have a directory index list that is long enough
for us to require the use of a scroll bar.  Our desired target for this example will be Ulti-Mate Software
Development.  When we entered this record into the file, we used an index of  software.  We want to
quickly go through the list and select this item to display.  Using the scroll bar will accomplish the job, but
what if we had a list with several hundred entries.  That would be extremely slow.  Follow the steps when
using the sample file to see how this function gets us to our target name rather quickly.
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1. Open the data file called sample.abk, this is a long list with our target well out of view. 

2. Click on the search text box above the directory index to place the cursor in this box.

3. Type the letter S which is the first letter of the index we want to see.

4. You will see that the index software is now selected and can be viewed by clicking the VIEW
NAME button.

While you are entering a search string in this box, every time a new letter is added the directory index will
display the first  entry it  finds that  matches the specification.   If  no match is  found,  no index will  be
highlighted.  This feature allows us to go through the alphabet quite rapidly.  For example, if we know the
target index starts with the letter S for example, by entering S into this box, the first entry that starts with
the letter S will become highlighted.  If our search spec is now changed to SA, then the first index it finds
that  start  with  the  letters  SA  will  be  displayed.   This  is  a  very  useful  feature  and  now  you  should
experiment with this feature in the sample file before proceding. 
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Address Book Features And Options

USING THE SEARCH BOX

The Search Box provides a means to create additional data files from another data file based on the search
specifications you select.  You can also have the data written to a Last Search data file for temporary use.
This file's contents is maintained until another search is initiated.  Finally you can have the search data
output to your printer.  All three options affect the contents of the lastdrch.abk file so remember that this
file is only a temporary storage area to hold to data in.  Currently wildcards are not supported in the search
string.  If public response to this program is good we will add wildcard and advanced search methods in
future upgrades.  As a final note, the search string is compared to the selected field from begining to end.
For example, if you select city and enter the string om as your specification, the search will find and store
Omaha but will  not store Colombus.  Since address book entries are usually very basic entries, there
should be no need for advanced search methods, however again we will say if public response requests it,
we will add it for you.  To perform a search, you will need a data file to create.  For our example, we will use
the sample.abk file again.  There is no need to open the file prior to conducting a search as you will be
prompted for a search filename and a save filename as necessary.  We will cover  search using the NAME
field and store it as a LAST SEARCH data file.

1. From the Options menu, click on SEARCH.

2. Select City/State from the Search By frame.

3. Select Last Search Data File from the Write Search To frame

4. For our example, we will add the string Bellevue for our search specification.

5. When ready, click the SEARCH button to begin the process.

6. An Open File dialog box will appear.  This box is to select the file that we want to conduct the
search in.

7. For the example, we will open the sample.abk file.  Click on this filename and then click on the
OK button.

8. The search will begin and when complete you will be back at the main display screen.  If the
search was     successful you will see nothing out of the ordinary and your data will now be
in the lastsrch.abk file which can     be opened like any other data file.  If no matches were found, you
will see a small message box appear     stating so.

If you selected the printer as your destination, the search data will be output as it's found.  We recommend
having the Print Manager active for this feature to prevent the program from pausing and waiting while
printing.  Plus even if your printer is off or not on-line, the file will be stored there for printing at a later
time.  See your Windows manual for more details on using the Print Manager.  If you selected Permanent
Data File as your write file destination, you will be prompted for a filename to save your search file as.
What will occur is that your last search data file will be renamed as the permanent data file.  Consequently
you will no longer see this file in your directory until you perform another search utilizing the last search or
print option.  If you attempt to print the last search data file, the program will create it for you however it
will contain no records to print and you will receive a message box stating so.  Remember the last search
file is  temporary in nature and by the action of saving this  file with a permanent filename, you have
eliminated the need for that particular search data that the file contained.  While at first your search
options may seem limited, this is not necessarily the case.   You have the ability to create one large
telephone directory and from it spawn smaller more specialized ones.  For the home PC user, this should
be more than adequate.  For a small  business that keeps customer lists  and telephone numbers,  the
Address Book has enough options to create and maintain a functional and efficient database.  The key to
keeping a good database is to develope a single format to enter your data in.  If you will be using a modem
with this program, the the telephone number entry will require the most stringent adherence to the format
you develope.

TIME/DATE DISPLAY
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The time and date display is a convenient option to give you a constant readout of the current system time
and date.  The display can be toggled off if you already have a utility in use that displays these items.
Additionally, toggling the display off frees up some processor time (however small) which can help increase
performance when tweaking your system in 386 Enhanced mode.
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CONFIGURING YOUR MODEM

To use you modem with  the Address  Book,  you will  need to  create a configuration file to  store  your
settings.  A file with a sample default configuration is included with the package.  If you should delete this
file for one reason or another, you will get a message box when loading the program stating you must
create another one.  The file is called sercomm.cfg and should be placed in the current directory that the
program is running in.  To configure your modem, choose  MODEM SETTINGS from the Options menu.
The blocks to include are fairly self explanatory and the default setting should work for most modems.  If
not you can experiment with different strings to get your system to work.  Currently the baud rate frame
serves no useful  purpose as  a baud setting is  not  required to  command the modem to dial  a  phone
number.  However with an eye to future use, we have placed the frame in the window and developed the
shell controls necessary to specify a baud rate.  Current plans for the Address Book might include the
possibility of a simple but convenient E-Mail system between different users of the Address Book.  Once
again, public response to this program will determine if these upgrades are ever implemented.

Changes to your modem configuration are used immediately and there is no need to close and reopen the
program to activate them.  There is  a  concern about the reliability  of using COM 3 or COM 4 under
Windows.  Adequate testing can not be performed for any ports other than COM 1 or COM 2.  If you
experience any problems or even have success using these ports, please do us an immense favor and let
us know.  To configure your modem, follow these steps;

1. Click on MODEM SETTINGS from the options menu

2. Select the comm port you will be using from the Port frame

3. In the Modem Commands frame, enter your preferences for the different command strings
required.  Our     suggestion  here  is  to  keep  it  simple.   During  the  development  of  this
program, various options were tried and         some had very undesireable effects.  Remember
that you just want to dial a phone number, not establish an     MNP or v42 link.

4. When all settings are entered, click the OK button and your all set to go.

If you are unsure of what command strings to use, first try the default settings.  These are the most basic
commands that can be sent to the modem and should work for all Hayes compatable modems.  Once you
get the dial function to work, than you can alter the volume and dialing speed  to suit your taste.

THE NOTE WRITER

The note writer is nothing more than a scratchpad to leave temporary notes to yourself or to others who
may be happening to use the program.  The contents of each note page are stored only for the life of the
program.  That is, when the program ends, all notes are deleted.  They are there for the sole reason to
leave a reminder for yourself or to take a temporary message during the Address Book session.  If you
require a more permanent function, than use the memo writer or the Notebook included with Windows.
Page control is through a set of small buttons located on the lower right hand corner of each note.  Actually
these are not true buttons, only pictorial representations of buttons.  Using the note writer is very easy.  To
start, follow these steps;

1. Click on POST NOTES from the Memo menu.

2. The note page will appear on your screen.  

3. To enter a message, just begin typing.

4. To save a note and return to the main display, you will see a small button with a book on it.
Click on this     button and you will return to the program.  If you entered text, than that text
will be stored automatically for     you and the Notes indicator will illuminate indicating you
have notes waiting.  If no text was entered, there will     be no storage and no indicators.

5. To enter multiple notes, call up the note page as mentioned in step 1, enter your first note.  On
the lower         corner next to the Book button, you will see a small forward read button.
Click on it to go to the next page.

6. You may enter the next page of notes.  You will also see now that a backward read button has
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appeared.  To     go back to the previous page you can click here.  When done entering notes,
click the Book button to return     to the main display.
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Whenever notes are waiting, the indicator will be lit advising you of such.  You have no control over the
notes other than adding new ones or deleting all the notes at once.  Remember this function is only for
quick little reminders and it shouldn't be necessary to have the full file system controls that are available
with the Windows Notepad.  After you have entered a note, clicking on the Post Notes menu again will
allow you to view those notes.  To enter another note, either delete all the notes or click on the forward
read button till you come to a blank page and enter it there.  The forward and back buttons can be used to
cycle through all the notes.  When you are complete with the notes or wish to delete the present ones,
follow these simple steps.

1. Click on DELETE NOTES from the Memo menu and the note pad will be cleared and ready for
new entries.

2. The notes indicator will then go out indicating you have no notes waiting.

You will notice at the bottom also is a label containing the time the note was left.  This was added as a user
convenience and cannot be changed.  When you exit the notepad, the time that is stored with the note is
the time that you actually exited the function, not the time you first called up a note.

THE MEMO WRITER

The memo writer takes up where the note writer left off.  If you need to make a permanent note which you
can save to disk, than use this option.  While the memo writer does indeed have a print function, the
printed output is not formatted and really can't be recommended in place of the Windows Notepad.  While
you do have limited font support, this is for display only and does not affect the printed output.  Once
again, we did not add these to compete with the Windows accessories that came with the system, instead
we wanted to give you an option where you could enter and store rough text notes without having to open
the Notepad or Write program, or any other editor you might be using.  To begin using the memo writer,
follow these steps;

1. Click on MEMO WRITER in the Memo menu.  In a couple seconds, the memo editor will appear.

2. It's very unremarkable in appearance and is purposely designed so.  We tried to make it as
easy as possible     to use.

3. To begin using the editor, simply start typing.

4. To save your memo, click on the Save option from the File menu.  You will  go through the
normal file save     process of entering a filename and such.

5. To read a previously stored memo, click on Open in the File menu.  A File Open dialog box will
appear and     from that you can select your memo to load.

6. To start a new memo, click on New in the file menu.  When ever any memo activity required the
save option      to be called, the memo indicator will light to show new memos have been
added.  Since this is slightly     different  than  the  notes  indicator,  you  can  reset  this
indicator by clicking anywhere over the area of the icon.

7. Finally, to print a memo, click on print.  This will only print the currently opened memo.

8.  The edit commands, Cut, Copy, and Paste, function the same as in other Windows applications.

9. To change fonts, click on the font menu.  The current selection will be checked and you can
change it to any     other item in the menu.  Note that this will cause a global font change, not
from just that point on.

10. To change font size, click on the Size menu, and choose a new font size.  The current selection
will be       checked.  This too will invoke a global size change.

11. Finally, to change style, click on the style menu and choose your option.

Again, font support including styles and sizes is not extensive and doesn't need to be when you look at the
context of what the memo writer is to be used for.  Remember these are not designed as replacements for
any Windows text editor, only as a simple time saving accessory that has a use in the Address Book.
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INFORMATION MENUS

The information menus, under the About menu, will provide a little information about the program and
about our company.  Yes they're added more for ego purposes than anything else but look at it this way.  If
for some reason you destroy your data file, you at least will still have the number for Ulti-Mate Software
and can call and tell us about it.
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Registration
WHY SHOULD YOU REGISTER

Okay, now that you've had a chance to look over our product, you will have to decide.  Do you like what
you see and think that you will keep using it?  This is one of the greatest benefits of shareware.  Try before
you buy.  So, why should you register it.  Well, in the long run, the one who would benefit most from
registering our products would be you,  the end user.   If  you see something you like,  nothing would
encourage an author more than to receive compensation for the time spent developing a program.  The
more new sharware released, the more choices you have when looking for a particular piece of software.
Okay, you figured that one out already.  Now why should you register THIS program.  Well for starters, lets
take a look at Windows itself.  It is a good environment that has really not been given a fair evaluation.
Why?  Well there really isn't much we can do with it at the present time.  I read alot of bad press on what a
poor performer it is compared to something like Desqview for multi-tasking DOS applications.  Well no
kidding!  It wasn't developed to run DOS applications.  What Windows really needed was a product like
Visual Basic.  It is affordable enough for all us armchair programmers to get out there and start chugging
out applications for Windows and finally give the rest of the users something to do with it.  By registering
this software  you will encourage more and more releases to increase the productivity for the Windows
environment.  So if you like what you see, send in the fees and give the Windows market a goods shot in
the arm.  And while you're at it, you'll be giving Ulti-Mate Software Development a much needed shot in
the arm too!

HOW TO REGISTER

Registering this program is quite a simple matter.  At the end of this document, you will find the necessary
form to send in with your registration fee.  Just fill it out and send to the following address;

Ulti-Mate Software Development
P.O. Box 132

Bellevue, NE.  68005-0132

Include with the form a check or money order for $9.95 and consider yourself a registered owner of the
Address Book for Windows.  Now you're probably saying to yourself,  "Wait  a minute, I  didn't see any
options to enter a registration number."  Thats right and you won't find any in this program.  First of all,
look at the price, it is a very reasonable price for a program especially considering that shareware for
Windows tends to  be rather  overpriced  for  limited  usefulness.   Second,  when you  buy a commercial
program, you are not bothered by registration messages or the fact that you have to enter a special
number to eliminate them.  You are carried by the company as a registered user and that's what we will do
here also.

Okay, so what does registration get you.  Well for one, you will be given access to our bbs and the support
section for any help that you might need or problems that you run into.  Your name will also go on our
mailing list where we can notify you of new releases that you might be interested in long before you ever
see or hear about them on a bbs.  If we upgrade this piece of software, you will be sent the latest copy and
will not be required to pay for it again.  Register this once and you are a lifetime owner of the program.
The bottom line is that we believe that if users feel a program is truly a good one, they will pay for it
without having to be harassed or intimidated into doing so.  What you have to do is look at the program,
see if you like it, compare the program against our asking price, then decide if you think it's worth it.  What
we will harass you and intimidate you in to doing though, is that if you feel this is really a bad program,
please write and let us know why so we won't make the same mistakes again.  The biggest responsibility a
user of shareware has is to provide feedback to the authors.  We trust your judgements and appreciate a
critique, no matter how bad.

HOW TO GET HELP

Okay, you have a problem.  You read through this document over and over and can't find the solution to
your  problem.   Or  maybe you have a bug,  either  serious  or  minor  that  you want  to  report  and get
corrected.  Well there are two ways to do this.  First you can write to us at the address mentioned above.
Secondly you can call our bbs and request help.  The number will be listed at the end of this section.
Please give full details of any problems you have.  What you were doing at the time of the problem, and
any other relevant information concerning hardware or other software in use.  We will get a reply back out
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to you as soon as we can.  If you call, you can expect an answer within 24 hours or at least confirmation
that we have received your message and are working on a solution.  When you access our board, don't be
afraid to voice your opinions.  We need to hear from you to help us fo a better job.  
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REQUESTS FOR CUSTOM SERVICE

As Ulti-Mate Software products become more advanced, we hope that they will  fill  all  your computing
needs.  However, if there is a special function you would like added to your program, please feel free to
inquire about having it done.  We would ask that you send your request in a detailed letter giving a full
description of the modification you desire.  We will  answer with a confirmation letter,  requesting your
approval of the design we propose to implement.  If it matches what you want, we will  go ahead and
produce the change and forward the modified program to you.  We will charge a small fee for this service
with rates being determined by the type of modification requested and the amount of work it takes to
develope your request.  These fees should never exceed 50% of the registration cost of the program itself.
Due to the modular nature of Visual Basic ( a lazy man's programming environment ) we can have your
mod out in a very short period of time.  

ULTI-MATE SOFTWARE

Ulti-Mate Software Development is a group of programmers dedicated to bringing you low cost alternatives
to the run-away prices of todays shareware market.  Take a look at the programs available today in the
shareware world.  Most cost just as much as a comparable commercial product and you get so much less
with a shareware product.  We don't like paying $40.00 for a product that doesn't include a printed manual,
doesn't  include  technical  support,  doesn't  include  upgrades  or  even  a  discounted  upgrade offer.   No
wonder people aren't paying for shareware anymore.  We hope to change that and we hope you will help
us.  We here at Ulti-Mate Software deplore the practice of crippling software in an attempt to increase
registrations.  You will never find a crippled piece of software with the USD title on it.  We believe that a
program will stand or fall based on it's own merits.  If it's good, people will pay for it.

In  no  event  shall  Ulti-Mate  Software  Development  be  liable  for  any  damages  whatsoever  (including,
without limitation, damages for loss of business profits, business interruption, loss of business information,
or other monetary loss) from the use, misuse, or inability to use this Ulti-Mate Software Development
product.

It has been brought to our attention that certain national networks have been making illegal claims against
copyrighted  material  once that  material  has  been uploaded onto their  systems.   Please note that  all
products from Ulti-Mate Software are fully protected by the copyright laws of the United States.  No one
and we mean no one may make any claims of ownership against any material contained in our distribution
packages including but not limited to programs, datafiles, documentation and any other work we deem
appropriate.  No one except Ulti-Mate Software Development and their licensed agents may collect fees for
the distribution of Ulti-Mate Software products.  This does not include those bulletin board systems where
the sysops may request donations to offset the cost of operating the system.  This does include those
bulletin boards however that charge mandatory fees for download access.  You DO NOT have the right to
make money from the efforts of the staff at Ulti-Mate Software Development.  

Parts NOT!  Bulletin Board Service

Ulti-Mate Software owns and operates a bulletin board service as a means to distribute our software and as
a place for our users to call with their problems.  Our bbs is operated 24 hours a day, 7 days a week, and is
free of charge.  Our user base will be limited to USD customers, registered and unregistered, and all users
have access to our file areas and message areas.  Non-registered users will be restricted from the technical
support areas but otherwise have free run of the system.  We offer a friendly message base area although
we do not and will not support net mail conferencing.  That is not our purpose and we'll let the general
purpose bbs' out there handle that function.  We do not restrict downloads or require a ratio of uploads to
downloads.  That would be counter-productive to our growth.  As a matter of fact, we will not accept any
shareware unless you have specifically written it yourself.  As a result, we will not have the large shareware
areas that most bbs' have however we will carry our own products and those of anyone who chooses to
utilize our board for distribution.  We do not charge any fees or make any claim of ownership against any
material uploaded to our system for distribution.  We have our own work and do not need to make false
claims against others.  What immediate benefits do you get from doing this?  If we need to send a copy of
one of our products on disk to any customer out there, we will always include some sample files from our
board to help spread your work out around the country.  We may in the course of business upload large zip
packages to other bbs' around the country and may include yours as well.  We want to offer as much
support to our customer as possible and we hope by offering these small  services you will  choose to
become a regular user of USD products and join us on the Parts NOT! bbs.
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Parts NOT!  BBS
Call Us Today!

(402) 734-4288
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Registration for Address Book

Name:                                                                                                                             

Address:                                                                 

City/State:

Zip Code:

Telephone:

Please Tell us where you obtained this program from:

Give us your impression of this product:
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Would you use other products from Ulti-Mate Software:
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